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External Control 
Template List

HINT
1. These operations will overwrite the previous MIDI Control settings.  If necessary, back up the previous MIDI Control file.
2. When the MIDI channel settings of the host application and the plug-in software are the same,  proper control may not be 

available.  Please change the MIDI channel setting on either the host application or the plug-in software. Please refer to the 
application's manual for the correct setting.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4

KORG KLC M1
A

Name OSC BAL RESO CUTOFF EG INT Click the controller logo on the “PERFOR-
MANCE” page. Select “Load Controller Map...” 
from  the displayed controller menu. Load the 
controller setting file “M1.cmap” from  the 
“Presets” folder inside the folder where the 
KORG Legacy Collection is installed.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#8 CC#71 CC#74 CC#79

B

Name ATTACk DECAY RELEASE IFX BAL

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#72 CC#91

C

Name Volume - - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#7 off off off

KLC 
WAVESTATION A

Name Vector X Vector Y - Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 off CC#7

B

Name Vector X Vector Y - Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 off CC#7

C

Name Vector X Vector Y - Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 off CC#7

KLC MS-20
A

Name VCO 1 WAVE FORM VCO 2 WAVE FORM VCO 1 LEVEL VCO 2 LEVEL Click the “KORG” logo. Select “Load Controller 
Map...” from the displayed KORG logo menu.  
Load the controller settings file “MS-20.cmap” 
from the “Presets” folder inside the folder  
where the KORG Legacy Collection is 
installed.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#82 CC#20 CC#21

B

Name HPF CUTOFF LPF CUTOFF HPF PEAK LPF PEAK

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#28 CC#74 CC#29 CC#71

C

Name EG 1 DELAY EG 1 ATTACK EG 1 RELEASE VOLUME

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#24 CC#23 CC#26 CC#7

KLC Polysix
A

Name VCO WAVE FORM VCO PWM ADJUST VCO PWM SPEED MG FREQUENCY Click the “KORG” logo. Select “Load Controller 
Map...” from the displayed KORG logo menu.  
Load the controller setting file “Polysix.cmap” 
from the “Presets” folder inside the folder  
where the KORG Legacy Collection is 
installed.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#14 CC#15 CC#27

B

Name MG DELAY TIME MG LEVEL VCF CUTOFF VCF RESONANCE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#24 CC#76 CC#74 CC#71

C

Name EG ATTACK EG DECAY EG SUSTAIN EG RELEASE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#70 CC#72

KLC 
LegacyCell A

Name Syn1 Cut Syn1Reso Syn1 A Syn1 R Click the controller logo on the “PERFOR-
MANCE” page. Select “Load Controller Map...” 
from  the displayed controller menu. Load the 
controller setting file “LegacyCell.cmap” from  
the “Presets” folder inside the folder where 
the KORG Legacy Collection is installed.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#28 CC#29 CC#30 CC#31

B

Name Syn2 Cut Syn2Reso Syn2 A Syn2 R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#85 CC#79

C

Name Syn1 Oct Syn1 Prm Syn2 Oct Syn2 Prm

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#15 CC#82 CC#22

microKORG
A

Name OSC 1 Wave Filter Cutoff Filter Resonance Filter EG Int 1. Set the microKORG's EDIT SELECT 2 knob to 
“MIDI”.  Move Knob 1 to set the MIDI CH to “1”. 
Move Knob 3 to set the CLOCK to “Ext”. 

2. Set the EDIT SELECT 2 knob to “GLOBAL”. Move 
Knob 4 to set the POSITION to “PrE” (Pre TG). 

3. Press the 4 key while holding the SHIFT key 
to enter MIDI Filter settings.  Move Knob 1 to 
select “P-E” (PROGRAM CHANGE Enabled).  
Move Knob 2 to select “C-E” (CONTROL 
CHANGE Enabled).  Move Knob 3 to select “b-
E” (PITCH BEND Enabled).

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#74 CC#71 CC#79

B

Name F.EG Attack F.EG Decay F.EG Sustain LFO 1 Frequency

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#23 CC#24 CC#25 CC#27

C

Name A.EG Attack A.EG Decay A.EG Sustain A.EG Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#70 CC#72

MS2000/R
A

Name OSC 1 Wave Filter Cutoff Filter Resonance Filter EG 1 Int 1. Press the [GLOBAL] key to enter Global mode. 
Set “Position” on the “GLOBAL” page to “Pre 
TG”. 

2. Press the [PAGE] key to move to the “MIDI” 
page. Set “MIDI Ch” to “01” and “Clock” to 
“External”. 

3. Press the [PAGE] key to move to the “MIDI 
FILTER” page.  Set “ProgChg” to “ENA”, 
“CtrlChg” to “ENA”, “P.Bend” to “ENA”, 
“NoteRcv” to “ALL”,  and “TimbreSelect” to 
“CC#95”.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#74 CC#71 CC#79

B

Name EG 1 Attack EG 1 Decay EG 1 Sustain LFO 1 Frequency

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#23 CC#24 CC#25 CC#27

C

Name EG 2 Attack EG 2 Decay EG 2 Sustain EG 2 Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#70 CC#72

These product names are trademarks or registered trademarks of KORG Inc.
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Ableton Live
A

Name Track 1 Pan Track 2 Pan Track 3 Pan Track 4 Pan Load the “KORG microX template.als” file.
Select “Preferences...” in the “Options” menu 
(or select “Preferences...” from  the “Live” 
menu on the Mac) to open the “Preferences” 
dialog.  Set “Input” of “Remote Control” to 
“microX(KEYBOARD)”.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 CC#19

B

Name Track 1 Volume Track 2 Volume Track 3 Volume Track 4 Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#24 CC#25 CC#26 CC#27

C

Name Scene Select Tempo Change A Return Volume Master Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#41 CC#80 CC#42 CC#07

This product name is a trademark or a registered trademark of Ableton AG.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4

Applied 
Acoustics 
Systems

Lounge 
Lizard EP A

Name Mallet Stiffness 
Soft/Hard

Mallet Force 
Strength

Mallet Noise Pitch Mallet Noise Decay Lounge Lizard EP-2 :
Select “Import...” from the “File” menu and 
load the setting file “KORG Midi Links.lxf”.

Lounge Lizard EP-3 :
Select “Import...” from the “File” menu and 
load the setting file “KORG Midi Links.lx3”

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#59 CC#80 CC#61 CC#65

B

Name Fork Tine Decay Fork Tine Volume Fork Tine Bar Decay Fork Tine Bar Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#81 CC#60 CC#83 CC#62

C

Name Pickup Symmetry Pickup Distance EQ Low/bass Gain Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#63 CC#87 CC#82 CC#7

Ultra Analog 
VA

A

A

Name OSC1 Detune OSC1 PW FILTER1 Cutoff FILTER1 Q Select “Import...” from the “File” menu and 
load the setting file “KORG Midi Links.axf” file.Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#44 CC#45 CC#46 CC#47

B

Name AMP1 Level AMP1 Pan LFO1 Rate LFO1 Delay

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#48 CC#49 CC#50 CC#51

C

Name AMP ENV1 A AMP ENV1 D AMP ENV1 S AMP ENV1 R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#56 CC#57 CC#58 CC#59

B

A

Name OSC2 Detune OSC2 PW FILTER2 Cutoff FILTER2 Q Select “Import...” from the “File” menu and 
load the setting file KORG Midi Links.axf file.Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#102 CC#103 CC#104 CC#105

B

Name AMP2 Level AMP2 Pan LFO2Rate LFO2 Delay

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#106 CC#107 CC#108 CC#109

C

Name AMP ENV2 A AMP ENV2 D AMP ENV2 S AMP ENV2 R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#87 CC#88 CC#89 CC#90

String Studio 
VS

A

A

Name Chorus Mix Chorus Depth Chorus Rate Delay Mix Select “Import...” from the “File” menu and 
load the setting file “KORG Midi Links.sxf” fileCh Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#44 CC#45 CC#46 CC#47

B

Name Delay Depth Delay Rate Reverb Mix Reverb Decay

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#48 CC#49 CC#50 CC#51

C

Name Vibrato Rate Vibrato Fade Vibrato Amount Keyboard Detune

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#52 CC#53 CC#54 CC#55

B

A

Name Excitator Prot (Force, 
Mass)

Excitator Stiff 
(Friction)

Excitator Velocity Filter Cutoff Select “Import...” from the “File” menu and 
load the setting file “KORG Midi Links.sxf” file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#102 CC#103 CC#104 CC#105

B

Name Filter Q EQ Low Gain EQ Mid Gain EQ High Gain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#106 CC#107 CC#108 CC#109

C

Name Mass Low Freq Mid Freq High Freq

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#87 CC#88 CC#89 CC#90

These product names are trademarks or registered trademarks of Applied Acoustics Systems DVM Inc.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4
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Arturia minimoog V
A

Name Wave Osc 1 Wave Osc 2 Wave Osc 3 Cutoff Copy the setting file “controlMidi” into the fol-
lowing folder:
Windows : The “save” folder inside the folder 
where minimoog V is installed.  (e.g. C:/Pro-
gram Files/Arturia/minimoog V/save)
Mac:  /Library/Preferences/minimoog V/save 
folder This operation will overwrite the previ-
ous MIDI Control settings.  If necessary, back 
up the previous controlMidi file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 CC#74

B

Name Emphasis VCF Attack VCF Decay VCF Sustain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#71 CC#49 CC#50 CC#51

C

Name Amount VCA Attack VCA Decay VCA Sustain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#87 CC#88 CC#89 CC#90

CS-80V
A

Name HighPass 1 Cutoff LowPass 1 Cutoff HighPass 2 Cutoff LowPass 2 Cutoff Copy the setting file “controlMidi” into the fol-
lowing folder: 
Windows : The “save” folder inside the folder 
where CS-80V is installed. (e.g. C:/Program 
Files/Arturia/CS-80V/save)
Mac : /Library/Preferences/Cs80V/save folder. 
This operation will overwrite the previous 
MIDI Control settings.  If necessary, back up 
the previous controlMidi file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 CC#19

B

Name Attack Time Vca 1 Release Time Vca 1 Attack Time Vca 2 Release Time Vca 2

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#48 CC#49 CC#50 CC#51

C

Name RingMod Speed RingMod Modula-
tion

Mix Osc1 Osc2 Brilliance

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#80 CC#81 CC#89 CC#90

moog 
modular V

A

A

Name Filter 1 Resonance Filter 2 Resonance Filter 3 Resonance - Copy the setting file “controlMidi” into the fol-
lowing folder:
Windows : The “save” folder inside the folder 
where Moog Modular V is installed. (e.g. C:/
Program Files/Arturia/Moog Modular V/save)
Mac:/Library/Preferences/MoogModularV/
save folder This operation will overwrite the 
previous MIDI Control settings.  If necessary, 
back up the previous controlMidi file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 off

B

Name Oscillator 1 
Coarse tune

Oscillator 2 
Coarse tune

Oscillator 3 
Coarse tune

-

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#19 CC#48 CC#49 off

C

Name Filter 1 Cutoff 
Frequency

Filter 2 Cutoff 
Frequency

Filter 3 Cutoff 
Frequency

-

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#80 CC#81 CC#82 off

B

A

Name 125Hz Band Gain 350Hz Band Gain 1000Hz Band Gain 2800Hz Band Gain Copy the setting file “controlMidi” into the fol-
lowing folder:
Windows : The “save” folder inside the folder 
where Moog Modular V is installed. (e.g. C:/
Program Files/Arturia/Moog Modular V/save)
Mac: /Library/Preferences/MoogModularV/
save folder This operation will overwrite the 
previous MIDI Control settings.  If necessary, 
back up the previous controlMidi file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#106 CC#107 CC#108 CC#109

B

Name 175Hz Band Gain 500Hz Band Gain 1400Hz Band Gain 4000Hz Band Gain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#110 CC#111 CC#112 CC#113

C

Name 250Hz Band Gain 700Hz Band Gain 2000Hz Band Gain 5600Hz Band Gain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#114 CC#115 CC#116 CC#117

ARP2600V A

A

Name POLTAMENTO TIME DELAY Dry/Wet DELAY time L DELAY time R Copy the setting file “controlMidi” into the fol-
lowing folder:
Windows : The “save” folder inside the folder 
where ARP2600V is installed. (e.g. C:/Program 
Files/Arturia/ARP2600V/save)
Mac : /Library/Preferences/arp2600v/save 
folder This operation will overwrite the previ-
ous MIDI Control settings.  If necessary, back 
up the previous controlMidi file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#44 CC#45 CC#46 CC#47

B

Name AUDIO VCO1 AUDIO VCO2 AUDIO VCO3 Encoder 8 
AUDIO NOISE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#48 CC#49 CC#50 CC#51

C

Name A D S R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#56 CC#57 CC#58 CC#59

B

A

Name INT.FIRTER 
FREQUENCY

RESONANCE ADSR FILTER TYPE Copy the setting file “controlMidi” into the fol-
lowing folder:
Windows : The “save” folder inside the folder 
where ARP2600V is installed. (e.g. C:/Program 
Files/Arturia/ARP2600V/save)
Mac :  /Library/Preferences/arp2600v/save 
folder This operation will overwrite the previ-
ous MIDI Control settings.  If necessary, back 
up the previous controlMidi file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#52 CC#53 CC#54 CC#55

B

Name Seq Step1 Seq Step2 Seq Step3 Seq Step4

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#80 CC#81 CC#82 CC#83

C

Name Seq Step5 Seq Step6 Seq Step7 Seq Step8

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#87 CC#88 CC#89 CC#90

These product names are trademarks or registered trademarks of Arturia SA.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4

Apple GarageBand
A

Name Pan Volume - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#10 CC#7

B

Name Pan Volume - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#10 CC#7 off off

C

Name Pan Volume - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#10 CC#7 off off

This product name is a trademark of Apple Computer, Inc., registered in the US. and other countries.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4
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FXpansion BFD
A

Name Overhead Distance Overhead Width Room Distance Room Width Click the “Load” icon (located in the upper 
right corner of the BFD window) to load the 
“BFD_KORG.bfd” file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#21 CC#20 CC#23 CC#22

B

Name PZM Distance PZM Width Direct Master Level Overhead Level

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#25 CC#24 CC#16 CC#17

C

Name Room Level PZM Level Master Dynamics Master Level

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#18 CC#19 CC#11 CC#7

This product name is a trademark or a registered trademark of FXpansion Audio UK Ltd.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4

GMEDIA impOSCar
A

Name Filter Separation Filter Q Filter Freq Env->Filter

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#71 CC#74 CC#52

B

Name Filter Attack Filter Decay Filter Sustain Filter Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#47 CC#48 CC#49 CC#50

C

Name Vel->Attack Vel->Release Vel->Drive Vel->Env2

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#36 CC#37 CC#38 CC#39

M-Tron
A

Name Tone Pitch Pan Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#95 CC#10 CC#7

B

Name Amp Envelope 
Attack

Amp Envelope 
Release

- -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#72 off off

C

Name - - - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# off off off off

Oddity

A

Name VCF Cutoff 
Frequency

VCF Resonance HPF Cutoff Freq Q LFO Freq Q

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#9 CC#8

B

Name VCF Mod 2 Amount VCF Mod 3 Amount AR Attack AR Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#1 CC#11 CC#73 CC#72

C

Name ADSR Attack ADSR Decay ADSR Sustain ADSR Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#75 CC#76 CC#77 CC#78

minimonsta
A

Name Osc 1 Waveform Osc 2 Waveform Osc 3 Waveform Filter Cutoff For stand-alone operationWindows: Click the 
SET UP button in the lower right part of the 
minimonsta window to open the menu. Click 
on Input device and select microX KEYBOARD 
Mac: Click the SET UP in the lower right part of 
the minimonsta window to open the menu. 
Click on Input device and select CoreMIDI. 

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 CC#74

B

Name Filter Emphasis Filter Attack Filter Decay Filter Sustain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#71 CC#20 CC#21 CC#22

C

Name Filter Amount of 
Contour

Loudness Attack Loudness Decay Loudness Sustain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#70 CC#73 CC#72 CC#15

These product names are trademarks or registered trademarks of GMEDIA Music.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4

Image-Line 
Software

FL Studio 5
A

Name Filter Cutoff Filter Emphasis - - For stand-alone and plug-in synthesizer oper-
ationSelect “MIDI settings” (located in the 
“OPTIONS” menu in the upper left corner of 
FL Studio 5 window), and select “microX 1  
KEYBOARD”. Select “Open” from the “FILE” 
menu, and load the “KORG microX.flp” file.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#91 CC#92 off off

B

Name Master Pan FX1 Pan FX2 Pan FX3 Pan

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 CC#19

C

Name Master Volume FX1 Volume FX2 Volume FX3 Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#80 CC#81 CC#82 CC#83

This product name is a trademark or a registered trademark of Image-Line Software.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4
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MOTU MachFive
A

Name Filter Cutoff Filter Resonance Drive Transpose

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#75 CC#76

B

Name Fine Tune LFO 1 Rate LFO 2 Rate Part Pan

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#96 CC#97 CC#10

C

Name - - - Part Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# off off off CC#7

Digital 
Performer A

Name Pan Pan Pan Pan 1. Select “Open...” from the “File” menu and 
open the song file “DP_microX_KORG.pref” 
(when using the KORG USB-MIDI Driver) or 
“DP_microX.pref” (when not using the KORG 
USB-MIDI Driver) .
(Please use this on “DP4 v4.12” or later.)

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#10 CC#10 CC#10 CC#10

B

Name Level Level Level Level

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#7 CC#7 CC#7 CC#7

C

Name Level Level Level Level

Ch Ch:05 Ch:06 Ch:07 Ch:08

CC# CC#7 CC#7 CC#7 CC#7

These product names are trademarks or registered trademarks of Mark of the Unicorn, Inc.

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT

1 2 3 4

Native 
Instruments

B4 A

A

Name SWELL Tube Drive Tube Body Tube Brightness

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#011 CC#076 CC#078 CC#079

B

Name Key Click Perc. Volume Perc. Decay Perc. Harmonic

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#075 CC#070 CC#071 CC#072

C

Name Vibrato Mix Vibrato Depth Treble Rotaly Tone Bass Rotor Tone

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#74 CC#80 CC#90

B

A

Name Drawbars 16' Drawbars 5 1/3' Drawbars 8' Drawbars 4'

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#12 CC#13 CC#14 CC#15

B

Name Drawbars 2 2/3' Drawbars 2' Drawbars 1 2/3'' Drawbars 1/3'

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 CC#19

C

Name Drawbars 1' - - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#20 Off Off Off

Battery
A

Name Controller A Controller B Controller C Controller D Press the “OPTIONS” button and open the 
Preference dialog. Set the MIDI controllers as 
below.
A:CC#0, B:CC#1, C:CC#2, D;CC#3, E:CC#4, 
F:CC#5, G:CC#6, H:CC#7

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#0 CC#1 CC#2 CC#3

B

Name Controller E Controller F Controller G Controller H

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#4 CC#5 CC#6 CC#7

C

Name - - - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# Off Off Off Off

Elektrik Piano
A

Name Sound Control 1 Sound Control 2 Sound Contolr 3 Sound Contorl 4 Press the “OPTIONS” button to open the “Set-
tings” dialog.  Confirm that “USE STD. CC#7 / 
CC#10 VOLUME & PAN” is active. In case it is 
not active, click it.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#20 CC21 CC#22 CC#23

B

Name Pan Volume - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#10 CC#07 Off Off

C

Name - - - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# Off Off Off Off

FM7
A

Name Timbre Brightness Timbre Harmonic Timbre Detune Timbre Env Amount On the “MASTER” page, locate the “CONTROL-
LER DEFINE” parameters then press the 
“LOAD” button  for “CONTROLLER ASSIGN” to 
load the setup file “KORG microX.f7c”.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#102 CC#103 CC#104 CC#105

B

Name Timbre Envelope 
Attack

Timbre Envelope 
Decay

Timbre Envelope 
Sustain

Timbre Envelope 
Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#106 CC#107 CC#108 CC#109

C

Name Amp Attack Amp Decay Amp Sustain Amp Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#114 CC#115 CC#116 CC#117

PRO-53

A

Name Oscillator A 
Pulse Width

Oscillator B 
Pulse Width

Filter Cutoff Filter Resonance Click the “NI” logo. Select “Load Controller-
map” in the displayed menu and load 
“DefaultMap.txt”  from the “Presets”-“Control-
ler maps” folder inside the folder where PRO-
53 is installed.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#43 CC#55 CC#70 CC#71

B

Name Filter Attack Filter Decay Filter Sustain Filter Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#75 CC#76 CC#77 CC#78

C

Name Amplifier Attack Amplifier Decay Amplifier Sustain Amplifier Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#80 CC#81 CC#82 CC#83

These product names are trademarks or registered trademarks of Native Instruments Software Synthesis GmbH.
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Select
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HINT
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Propellerhead Reason Mixer A

A

Name Channel 1 Pan Channel 2 Pan Channel 3 Pan Channel 4 Pan

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#23 CC#24 CC#25 CC#26

B

Name Channel 1 
Aux 1 Send

Channel 2 
Aux 1 Send

Channel 3 
Aux 1 Send

Channel 4 
Aux 1 Send

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#39 CC#40 CC#41 CC#42

C

Name Channel 1 Level Channel 2 Level Channel 3 Level Channel 4 Level

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#8 CC#9 CC#10 CC#12

B

A

Name Channel 1 
Treble Amount

Channel 2 
Treble Amount

Channel 3 
Treble Amount

Channel 4 
Treble Amount

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#82 CC#83 CC#84 CC#85

B

Name Channel 1 
Bass Amount

Channel 2 
Bass Amount

Channel 3 
Bass Amount

Channel 4 
Bass Amount

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#68 CC#69 CC#70 CC#71

C

Name Channel 1 Level Channel 2 Level Channel 3 Level Channel 4 Level

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#8 CC#9 CC#10 CC#12

Dr.Rex
A

Name Filter Freq Filter Res Filter Mode Filter Env Amount

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#76 CC#18

B

Name Filter Env Attack Filter Env Decay Filter Env Sustain Filter Env Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#14 CC#15 CC#16 CC#17

C

Name Amp Env Attack Amp Env Decay Amp Env Sustain Amp Env Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#9 CC#12 CC#72

Malstrom
A

Name Oscillator A Motion Oscillator A Index Oscillator A Shift Oscillator A Gain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#92 CC#93 CC#86 CC#91

B

Name Oscillator B Motion Oscillator B Index Oscillator B Shift Oscillator B Gain

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#43 CC#42 CC#44 CC#53

C

Name Oscillator A Attack Oscillator A Release Oscillator B Attack Oscillator B Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#87 CC#90 CC#73 CC#72

NN 19
A

Name Filter Freq Filter Res Filter Mode Filter Env Amount

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#76 CC#18

B

Name Filter Env Attack Filter Env Decay Filter Env Sustain Filter Env Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#14 CC#15 CC#16 CC#17

C

Name Amp Env Attack Amp Env Decay Amp Env Sustain Amp Env Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#9 CC#12 CC#72

NN-XT
A

Name Filter Freq Filter Res Amp Env Attack Amp Env Decay

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#73 CC#9

B

Name Amp Env Release Mod Env Decay Master Volume -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#72 CC#15 CC#7 off

C

Name - - - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# off off off off

ReDrum
A

Name Drum 1 Pan Drum 2 Pan Drum 3 Pan Drum 4 Pan

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#19 CC#20 CC#21 CC#22

B

Name Drum 1 Pitch Drum 2 Pitch Drum 3 Pitch Drum 4 Pitch

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#51 CC#52 CC#53 CC#54

C

Name Drum 1 Level Drum 2 Level Drum 3 Level Drum 4 Level

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#8 CC#9 CC#10 CC#12

Subtractor
A

Name Osc1 Phase Diff Osc2 Phase Diff FM Amount Osc Mix

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#93 CC#106 CC#108 CC#107

B

Name Filter Freq Filter Res Filter2 Freq Filter2 Res

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#79 CC#78

C

Name Amp Env Attack Amp Env Decay Amp Env Sustain Amp Env Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#9 CC#12 CC#72

These product names are trademarks or registered trademarks of Propellerhead Software AB.
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Spectrasonics Atmosphere
A

Name Layer A Pan Layer B pan Filter Cutoff Filter resonance

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#083 CC#084 CC#077 CC#078

B

Name Layer A Level Layer B Level Master Filter Cutoff Master Filter 
Resonance

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#081 CC#082 CC#074 CC#071

C

Name Amp Attack Ampr Decay Amp Sustain Amp Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#073 CC#075 CC#076 CC#072

Stylus
A

Name PAN PITCH fine FILTER cutoff FILTER res

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#10 CC#83 CC#77 CC#78

B

Name FILTER env FILTER time LFO1 LFO2

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#79 CC#80 CC#87 CC#88

C

Name ENVELOPE A ENVELOPE D ENVELOPE S ENVELOPE R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#76 CC#72

Stylus RMX 1.5 A

A

Name Mixer: Level Part 1 Mixer: Level Part 2 Mixer: Level Part 3 Mixer: Level Part 4 Load the “KORGmicroX.ctl_rmx” as the MIDI 
Learn set file.Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#11 CC#12 CC#13 CC#14

B

Name Edit: Master Filter 
Tone Part 1

Edit: Master Filter 
Tone Part 1

Edit: Master Filter 
Tone Part 1

Edit: Master Filter 
Tone Part 1

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#74 CC#75 CC#76 CC#77

C

Name Edit: Master Filter 
Emphasis Part 1

Edit: Master Filter 
Emphasis Part 1

Edit: Master Filter 
Emphasis Part 1

Edit: Master Filter 
Emphasis Part 1

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#82 CC#83 CC#84 CC#85

B

A

Name Mixer: Level Part 1 Mixer: Level Part 2 Mixer: Level Part 3 Mixer: Level Part 4

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#11 CC#12 CC#13 CC#14

B

Name Edit: 
Pitch Coarse Part 1

Edit: 
Pitch Coarse Part 1

Edit: 
Pitch Coarse Part 1

Edit: 
Pitch Coarse Part 1

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#16 CC#17 CC#18 CC#19

C

Name Edit: 
Pitch Fine Part 1

Edit: 
Pitch Fine Part 1

Edit: 
Pitch Fine Part 1

Edit: 
Pitch Fine Part 1

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#48 CC#49 CC#50 CC#51

Trilogy
A

Name Layer A Pan Layer B Pan Cutoff Resonance

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#83 CC#84 CC#77 CC#78

B

Name Filter Env A Filter Env D Filter Env S Filter Env R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#97 CC#98 CC#99 CC#100

C

Name Layer A Level Layer B Level Master Filter Master Resonance

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#81 CC#82 CC#74 CC#71

These product names are trademarks or registered trademarks of Spectrasonics.
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Steinberg Cubase SX3 A
(Audio) A

Name Pan 1 Pan 2 Pan 3 Pan 4 First, you need to install the KORG USB/MIDI 
driver.
1. Select “Device Setup...” from the “Devices” 

menu and open the “Device setup” dialog.  
Select “Generic Remote” from the “Devices” 
list in the left column.  Select “keyboard”  for 
the “MIDI input” and  press the “Import” 
button. Load “Cubase_KORG.xml”.  (If you do 
not find “Generic Remote” in the left column, 
please add it using the “Add/Remove” 
function.)

2. Press the “Apply” button.

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#10 CC#10 CC#10 CC#10

B

Name Level 1 Level 2 Level 3 Level 4

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#7 CC#7 CC#7 CC#7

C

Name Send 1 - 1 Send 1 - 1 Send 1 - 1 Send 1 - 1

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#21 CC#21 CC#21 CC#21

B
(MIDI) A

Name Pan 1 Pan 2 Pan 3 Pan 4

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#41 CC#41 CC#41 CC#41

B

Name Level 1 Level 2 Level 3 Level 4

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#35 CC#35 CC#35 CC#35

C

Name - - - -

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# off off off off

A1
A

Name Oscillator 1 FM Filter Cutoff Filter Resonance Filter Drive

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#74 CC#71 CC#29

B

Name Fitler Env Attack Filter Env Decay Filter Env Sustain Filter Env Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#37 CC#38 CC#24 CC#25

C

Name Amp Env Attack Amp Env Decay Amp Env Sustain Amp Env Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#40 CC#41 CC#42 CC#43

Monologue
A

Name OSC1 DEPTH OSC2 PWM OSC2 DEPTH FX OVER DRIVE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#103 CC#19 CC#105 CC#70

B

Name FX DEPTH FX MIX DELAY FBK DELAY MIX

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#15 CC#93 CC#12 CC#91

C

Name AMP A AMP D AMP S AMP R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#84 CC#72

Tonic

A

Name ENV MOD ATTACK ENV MOD RELEASE ENV MOD DEPTH ENV MOD 
LFO MOD

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#72 CC#79 CC#78

B

Name RES CUT OFF DRIVE MIX

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#71 CC#74 CC#70 CC#8

C

Name LFO MOD DEPTH LFO MOD RATE LFO MOD SMOOTH LFO MOD MORPH

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#76 CC#5 CC#83

Embracer
A

Name OSC1 WAVE OSC1 TONE OSC1 WIDTH OSC2 WAVE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#9 CC#74 CC#16 CC#14

B

Name OSC1 TONE OSC1 COARSE OSC1 WIDTH MASTER RELEASE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#76 CC#83 CC#18 CC#72

C

Name OSC1 ATTACK OSC1 LEVEL OSC2 ATTACK OSC2 LEVEL

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#17 CC#75 CC#19

Groove Agent
A

Name Kick Volume Snare Volume Tom Volume Hi-Hat Volume In the host application, change the MIDI out-
put channel for MIDI track where you want to  
use “Groove Agent” to “ANY” or other multi-
channel outputs.

Ch Ch:01G Ch:02 Ch:03 Ch:04

CC# CC#73 CC#73 CC#73 CC#73

B

Name Ride Volume Crash Volume Perc 1 Volume Perc 2 Volume

Ch Ch:05 Ch:06 Ch.07 Ch:08

CC# CC#73 CC#73 CC#73 CC#73

C

Name SHUFFLE HUMANIZE LIMITER AMBIENCE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#78 CC#77 CC#16 CC#91

HALion
A

Name DCF CUTOFF DCF RESONANCE DCF VELOCITY DCF ENV. AMOUNT Enable “RECEIVE MIDI CONTROLLER” in “KEY/
CONTROL OPTION” of the “OPTIONS” page.Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#15 CC#80

B

Name DCF Envelop A DCF Envelope D DCF Envelope S DCF Envelope R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#83 CC#89 CC#85 CC#82

C

Name DCA Envelope A DCA Envelope A DCA Envelope S DCA Envelope R

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#79 CC#75 CC#72

Manufacturer
 Name

Product Name
Scene 

Variation
Select

Realtime Controls
HINT
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Steinberg Hypersonic
A

Name Hyperknob 1 Hyperknob 2 Hyperknob 3 Hyperknob 4

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 CC#19

B

Name GM Edit: 
cutoff

GM Edit: 
resonance

GM Edit: 
filt env att

GM Edit: 
filt env dec+rel

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CCC#74 CC#71 CC#77 CC#78

C

Name GM Edit: 
amp env att

GM Edit: 
amp env rel

Pan Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#72 CC#10 CC#7

Virtual 
Guitarist A

Name Shuffle Dynamics Timing Decay

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#76 CC#79 CC#78 CC#75

B

Name Stereo Width Presence Low Cut Mic Position

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#81 CC#80 CC#82

C

Name Wah Pedal Delay Mix Reverb Mix Volume

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#4 CC#89 CC#91 CC#7

Attack
A

Name Osc 1 Pitch Osc 2 Pitch Cutoff Resonance In the host application, change the MIDI out-
put channel for MIDI track on which  “Attack” 
is used for each of the sounds that you want 
to remote-control such as kick, snare, drum, 
etc.

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#13 CC#22 CC#37 CC#38

B

Name Env 1 Attack Env 1 Decay Env 1 Shape Env 1 Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#52 CC#53 CC#54 CC#55

C

Name Env 2 Attack Env 2 Decay Env 2 Shape Env 2 Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#56 CC#57 CC#58 CC#59

PPG Wave 2.V
A

Name BASIS VCF-CUTOFF VCF-EMPHASIS ENV1>VCF

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#8 CC#74 CC#71 CC#28

B

Name ENV1 ATTACK ENV1 DECAY ENV1 SUSTAIN ENV1 RELEASE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#18 CC#19 CC#20 CC#21

C

Name ENV2 ATTACK ENV2 DECAY ENV2 SUSTAIN ENV2 RELEASE

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#22 CC#23 CC#24 CC#25

These product names are trademarks or registered trademarks of Steinberg Media Technologies GmbH.
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Ultimate-
SoundBank

PLUGSOUND

A

Name Multimode 
Filter Cutoff

Multimode 
Filter Resonance

Multimode 
Filter Type

Multimode 
Filter Key Follow

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#77 CC#78 CC#81 CC#79

B

Name UVI Filter Cutoff UVI 
Filter Resonance

LFO Rate LFO Depth

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#96 CC#95

C

Name Amplitude Enve-
lope Attack

Amplitude Enve-
lope Decay

Amplitude Enve-
lope Sustain

Amplitude Enve-
lope Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#76 CC#72

Charlie
A

Name Filter Cutoff Filter Resonance Layer one Pan Layer two Pan

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# C#77 CC#78 CC#83 CC#84

B

Name Master filter cutoff Master 
filter resonance

Layer one level Layer two level

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#81 CC#82

C

Name Amp Envelope 
Attack

Amp Envelope 
Decay

Amp Envelope 
Sustain

Amp Envelope 
Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#76 CC#72

Ultra Focus
A

Name Filter Cutoff Filter Resonance Layer A Pan Layer B Pan

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# C#77 CC#78 CC#83 CC#84

B

Name Master 
filter cut frequency

Master 
filter resonance

Layer A Level Layer B Level

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#81 CC#82

C

Name Amp Envelope 
Attack

Amp Envelope 
Decay

Amp Envelope 
Sustain

Amp Envelope 
Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#76 CC#72

X-treme FX
A

Name Filter Cutoff Filter Resonance Layer A Pan Layer B Pan

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# C#77 CC#78 CC#83 CC#84

B

Name Master 
filter cut frequency

Master 
filter resonance

Layer A Level Layer B Level

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#74 CC#71 CC#81 CC#82

C

Name Amp Envelope 
Attack

Amp Envelope 
Decay

Amp Envelope 
Sustain

Amp Envelope 
Release

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#73 CC#75 CC#76 CC#72

These product names are trademarks or registered trademarks of Univers Sons, SA.
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Free Assgin Free Assgin
A

Name Free Free Free Free

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#16 CC#17 CC#18 CC#19

B

Name Free Free Free Free

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#48 CC#49 CC#50 CC#51

C

Name Free Free Free Free

Ch Ch:01G Ch:01G Ch:01G Ch:01G

CC# CC#80 CC#81 CC#82 CC#83

Manufacturer
 Name

Product Name
Scene 

Variation
Select
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HINT

1 2 3 4
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